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This Guide contains information on how to administer the 
Agilent VnmrJ 4.2 software, including

• Account administration

• Printer configuration

• Accounting administration

• Spectrometer calibration and autotest

• VnmrJ terminology

• Administration of the Locator
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1 Admin Quick Start 
 

Overview of Administrator Tasks

This chapter gives a description of typical Administrative 
tasks, including the creation and configuration of:

• user accounts

• operators

• printers

• probe files

Use the VnmrJ Admin interface to configure users, 
operators, and printers. Use the VnmrJ application to 
configure user account preferences and probe files.

Table 1 Summary of basic Administrator functions 

Function To do this See

Creating accounts and adding 
operators

Set default operator password “Setting the default operators 
password” on page 22

Create a User Account “Creating a single new user 
account” on page 22

Create Multiple User Accounts “Creating a single new user 
account” on page 22

“Creating multiple new user 
accounts” on page 24

“Creating multiple new user 
accounts” on page 24

Set up User defaults, templates, and 
directories

“User Defaults and Directories” on 
page 48

Delete a User Account “Deleting a user account” on page 30

Restore a User Account “Restoring a user account” on page 30

Add operators to a User Account “Adding operators to a user 
account” on page 40
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Admin Quick Start 1 
Remove operators from a User Account “Deleting operators from a user 
account” on page 46

Configure and modify operators profiles “Creating, Editing, Viewing, and 
Deleting Profiles” on page 55

Creating User Types (persona) and 
Assigning Privileges

Create a user type “Persona Manager - 
Administration” on page 56

Set user preferences “Persona Manager - Preferences” on 
page 58

Set user privileges “Persona Manager - Widgets and 
Rights” on page 59

Set user parameter panel access “Persona Manager - Parameter 
Panels” on page 60

Set user access to experiments “Persona Manager - Protocols” on 
page 61

Configuring printers

Set up Linusx printer “Setting up a Linux printer” on page 72

Set up a VnmrJ printer “Setting Up a Printer for VnmrJ” on 
page 74

Configuring probe files

Adjust solvent lock power and gain 
values

“Adjusting solvent lock power and gain 
values in the probe file” on page 68

Add or remove a nucleus in the probe 
file

“Adding and removing a nucleus in the 
probe file” on page 69

Table 1 Summary of basic Administrator functions (continued)

Function To do this See
VnmrJ 4.2 Administration Guide 11
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Starting the VnmrJ Admin Interface

VnmrJ Admin is used to perform the majority of the 
administrator tasks for VnmrJ. For more information on the 
VnmrJ Admin interface, see “The VnmrJ Admin 
Interface” on page 18.

1 Log in as the VnmrJ administrator, typically “vnmr1”. 

2 Double- click the VnmrJ Admin icon on the desktop.

Figure 1 VnmrJ Admin window

Users Panel User Profile Panel

File System Panel
12 VnmrJ 4.2 Administration Guide



Admin Quick Start 1 
System Configuration Window

For proper operation, the software must be configured to 
match the installed hardware. The system installer performs 
this task at the time of installing the spectrometer. The 
administrator should record the settings in the configuration 
for backup or reference, as there are no recording or backup 
capabilities in the software.

1 Log in as the VnmrJ administrator.

2 Double- click the VnmrJ desktop icon.

3 Click Edit in the main menu after VnmrJ starts.

4 Click System Settings to open the System Settings window.

5 Click System config. 

The spectrometer Configuration window appears. See 
Figure 2 on page 14.

Record the settings for future reference and then click Ok to 
close the window.
VnmrJ 4.2 Administration Guide 13
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Figure 2 Spectrometer Configuration window

In time, the value of the Lock Frequency will need to be 
reduced to ensure z0 can be adjusted for all solvents used. 
This window is where the value of the Lock Frequency can 
be set for all users.
14 VnmrJ 4.2 Administration Guide
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Getting Help

In addition to the online help provided in the VnmrJ 
software, Agilent supplies a variety of printed manuals. In 
addition, you can use the Agilent Spinsights website to 
access manuals, software patches, latest news, and more.

Agilent Spinsights on the Web

The Spinsights NMR and MRI community is a single online 
location where you can access a variety of resources to help 
you learn about and use your Agilent NMR/MRI system. In 
the Spinsights community, you can

• Help Yourself, by searching for: software patches, manuals, 
bug lists, application notes, videos, newsletters, and more.

• Help Each Other, by answering or posting questions in our 
discussion forums.

• Ask Agilent, by using the AskTAC link or making contact 
using the information in the Agilent Info area.

You must register the first time you access Spinsights.

To start using Spinsights, go to 
https://spinsights.chem.agilent.com/
VnmrJ 4.2 Administration Guide 15
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Contact Information

USA

Address:

Agilent Technologies, Inc.

5301 Stevens Creek Blvd.

Santa Clara, CA 95051

Telephone Numbers:

Toll Free: +1 (800) 227 9770

Agilent website (all countries)

To find contact information for your country, click the 
following link and then select your country.

http://www.chem.agilent.com/en- us/ContactUS/Pages/Co
ntactUs.aspx
16 VnmrJ 4.2 Administration Guide
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The VnmrJ Admin Interface

The VnmrJ Admin interface provides the tools for 
administering VnmrJ software and user accounts. (See 
Figure 1.) Select Administration functions from the menu 
bar.

Table 2 Management menu  

Menu item Description

Users Displays users in the users panel and makes available all the 
administrative functions, see “User Account 
Administration” on page 21.

Printers Displays printer functions using pop-up window, see 
Chapter 5, “VnmrJ Printer Configuration”.

Cost/Time 
accounting

VNMR ACCOUNTING window. See Chapter 7, “VnmrJ 
Accounting Administration”.

Console display 
sharing

Turns on sharing of display 0 for virtual network connections.

Export Log to 
CSV

Opens the Log to CSV Conversion pop-up, where you can 
export Administration Accounting log files to CSV (Comma 
Separated Value) format.

Exit Exits and closes VnmrJ Admin.

Table 3 UNIX menu  

Menu item Description

File system Pop-up window displays file system information; see 
“” on page 65, for more information and instructions.

Command window Opens an operating system terminal window.
18 VnmrJ 4.2 Administration Guide
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Table 4 Configure menu 

Menu Item Description

Users Select additional functions using pop-up windows:

• Convert users-opens the Change vnmr users to 
VnmrJ user window. See “Converting user accounts 
to VnmrJ” on page 31.

• Defaults-opens the default values window. See “User 
account defaults” on page 48.

• Update users-opens the Update VnmrJ Users 
window. See “Updating user accounts” on page 32.

Operators • Edit operators-opens the Modify Operators window 
(Modify Operators tab). See “Creating 
Profiles-Spectroscopy Accounts” on page 54.

• Delete operators-opens the Modify Operators 
window (Delete Operator tab). See “Changing the 
Icon on the Operator Login Screen” on page 65.

• Reset password-opens the Reset Operators 
Password window. See “Resetting the operator 
password” on page 40.

• Preferences-opens the Preferences window for 
setting the default operators password and for 
selecting a default login icon. See “Resetting the 
operator password” on page 40.

Edit profiles Creates and assigns user profiles containing the 
protocols, rights and tools. See “Creating, Editing, 
Viewing, and Deleting Profiles” on page 55.

Investigator list Enter investigators in the pop-up window.

Locator Config Lets you set an age limit on files so that only more 
recent files are kept in the Locator database. This 
enables the Locator to run faster. You can also turn off 
the Locator.

Background colors Changes the default background colors of the VnmrJ 
Admin windows.
VnmrJ 4.2 Administration Guide 19
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Table 5 Help menu 

Menu item Description

Manuals Opens the VnmrJ help, where you can open VnmrJ 
manuals in PDF format.

Spinsights Community 
Help Site

Opens the Agilent Spinsights help site in a browser. 
From Spinsights, you can access various 
downloads, manuals, and get help from different 
sources. https://spinsights.chem.agilent.com

About VnmrJ Opens information about the VnmrJ software. 
20 VnmrJ 4.2 Administration Guide
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User Account Administration

User accounts are created or set up using the VnmrJ Admin 
interface. You can use the VnmrJ Admin interface to set up 
new accounts and configuration, or assign a group of 
operators to a single user account. 

Review and configure user account default properties before 
creating a new user account. These properties apply to all 
new VnmrJ 4 user accounts. See “User Defaults and 
Directories” on page 48

Basic administrative User account tasks include: 

• setting the default password (do this first) — see “Setting 
the default operators password”

• setting up new accounts — see “Creating a single new user 
account”

• assigning operators to a user account — see “Adding 
operators to a user account” on page 40

• assigning operators e- mail account and levels — see 
“Assigning operators an e- mail address” on page 42

• assigning profiles — see “User Defaults and Directories” on 
page 48
VnmrJ 4.2 Administration Guide 21
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Setting the default operators password

To set the default password for a group of VnmrJ operators: 

1 Launch the VnmrJ Admin interface. 

2 Click Configure > Operators > Preferences. The Preferences 
window appears. 

3 Enter a password in Default Password for VnmrJ Operators.

Operators with an operating system account login use the 
operating system account password to access the walkup 
operator interface. Operators, both with and without an 
operating system account, can change their passwords by 
selecting Change Password from the Tools menu on their 
interface. Change Password will change both the Operator 
and operating system login password, if an operating 
system account exists.

4 Click OK.

Creating a single new user account

Use this procedure to create a single new user account. New 
user accounts will contain default values set in User Account 
Defaults, see “User Defaults and Directories” on page 48. To 
create multiple new user accounts, see “Creating multiple 
new user accounts” on page 24.
22 VnmrJ 4.2 Administration Guide
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1 Select Management.

2 Select Users.

3 Select Show all VJ Users.

4 Click New User.

New User appears with a box around it and the account's 
profile is displayed in the User Profile Panel.

5 Fill in the User Profile Panel as appropriate.

Figure 3 VnmrJ Admin window
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The User Profile Panel (by default) has five sections. See 
“User account defaults” on page 48 to view other fields, 
data dir, and so on.

6 Click Save User.

Creating multiple new user accounts

Use this procedure to create multiple new user accounts. 
The new user accounts will contain default values set in 
User Account Defaults, see “User Defaults and 

Field Description

User login Type login name and select TAB. Prompt is displayed 
in the user login field. 

User name Optional. Enter a user name.

Home directory New users with no operating system account:

Setup is automatic and applies the user defaults 
(see User Account Defaults). 

Current users with an operating system account:

The user's operating system account home directory 
is used. 

VnmrJ operators Optional. List other users with VnmrJ operation 
privileges.

Interface type Click the Option button to select the interface type, 
See “Assign VnmrJ interface to a user account” on 
page 28.
24 VnmrJ 4.2 Administration Guide
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Directories” on page 48. To create a single new user 
account, see “Creating a single new user account” on 
page 22.

1 Select Management from the main menu bar.

2 Select Users.

3 Click the New User arrow.

4 Select Multiple Users from the drop- down menu.

5 Click New Users (2 or more).

The Create 2 or more users window opens.

6 Enter the login name for each user. Separate each user 
name by a space.

7 Select the interface assigned to the multiple users. See 
“Assign VnmrJ interface to a user account” on page 28.

 

8 Click Update Users.
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The home directory is automatically setup (new users -  no 
operating system account) based upon the user defaults (see 
“User account defaults” on page 48). Or if the user was first 
set up as an operating system account, the user's operating 
system account home directory is used.

You can also create multiple new user accounts using a .csv 
file. For information, see “Using a .csv file to add multiple 
user accounts” on page 26

Using a .csv file to add multiple user accounts

Requirements for the .csv file

• The comment lines in the .csv file must start with a 
number. 

• In the first line, enter a list of column keywords separated 
by commas. The only required columns are login and 
itype. Column keywords can be listed in any order on the 
first line. List subsequent lines of values, separated by 
commas, in the same order as the column keywords listed 
on the first line.

• Default user information will be used for Information not 
defined in the .csv file, see “User Defaults and 
Directories” on page 48. 

Column keyword Description

login required-user login

itype required-Spectroscopy or Imaging

name full name or description

home home directory for user

email user email address

profile basic liquids, all liquids, common liquids, all imaging
26 VnmrJ 4.2 Administration Guide
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• For each subsequent line, enter a list of values separated 
by commas in the same order of column keywords listed 
in the first line. 

Example:

login,name,home,itype,email,profile

myuser1,My User 1,/home/myuser1,Spectroscopy,
user1mai@abc.com,BasicLiquids

myuser2,My User 2,/home/myuser2,Spectroscopy,
user2mai@abc.com,CommonLiquids

To create multiple new user accounts from a .csv file

1 From the menu bar, go to Management > Users. 

2 Select New User.

3 Select Multiple Users from the drop- down menu.

4 Select New Users (2 or more).

5 Select the Use File for User list input check box.

6 Select the Create button. 

7 Enter the file path for the .csv input file. 

8 Select the Add Users button. 

To delete multiple users through inputting a .csv file:

The input file format is technically the same as for adding 
users. The only required keyword and value are for “login”. 
That means the file must have the word “login” in the first 
non- comment non- empty line.

1 From the menu bar, go to Management > Users. 

2 Select New User.

3 Select Multiple Users from the drop- down menu.

4 Select New Users (2 or more).

5 Select the Use File for User list input check box.

6 Select the Delete button. 

7 Enter the file path for the .csv input file. 

8 Select the Delete Users button. 
VnmrJ 4.2 Administration Guide 27
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Assign VnmrJ interface to a user account

Each VnmrJ account can be assigned an interface and 
appropriate privileges. The main interfaces are listed in the 
following table.

Setting data directories for the Locator

The Data Directories tab (Figure 4) is used to set the 
directories to be searched and displayed in the Locator for 
the selected user.

Table 6 VnmrJ interface menu 

Interface Description

Spectroscopy The spectroscopy interface is designed for both 
automated and manual operation, with or without a 
sample changer. There can be two types of users of the 
spectroscopy account- the account owner and the 
operator.

Account owner The account owner is the operating system (OS) login 
user, and therefore, the owner of the account and any 
acquisitions and data while logged in. The VnmrJ login 
window (if displayed) sets the operator parameter and 
other properties set by VnmrJ Admin, such as the user 
profile, panellevel, etc. The account owner sets up the 
preferences and settings of the account.

Operator The operator is a user of the account but is not the OS 
login user of the account, therefore, does not own any of 
the files in the account. The operator has VnmrJ access 
via a name and password entered on the VnmrJ login 
window and can operate the software.

Imaging The imaging interface provides the user with the full 
range of functions necessary for the acquisition of MRI 
data, the design of imaging sequences, building study 
protocols, and processing of imaging data.
28 VnmrJ 4.2 Administration Guide
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1 Select a user from the list of buttons in the upper left of 
the VnmrJ Admin window. 

2 Click the Data Directories tab in the lower left corner of 
the VnmrJ Admin window. 

3 Click New Label to add a new directory. 

A row is added to the list of directories. 

4 Type a label for the new directory. The label for each 
directory must be unique for this user. For example, you 
cannot have two directories with labels of "My Data". 
Instead, label them "My Data 1" and "My Data 2". These 
directories are searched recursively when filling the 
database. It is usually best not to include a user's home 
directory (eg., /home/vnmr1) because the locator will have 
to search a large number of files to populate the database. 

5 To remove a directory, edit the directory line to be blank. 

Figure 4 Data Directories tab in VnmrJ Admin
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6 After adding or removing directories, click Save User to 
save this information.

Deleting a user account

Use this procedure to delete a user account.

1 Select Management.

2 Select Users.

3 Select Show all VJ Users.

4 Right- click the user's account and select Delete.

Only the user account is deleted- operators assigned to the 
account are not deleted. Operators can be assigned to other 
user accounts, see “Creating Profiles- Spectroscopy 
Accounts” on page 54, or deleted, see “Changing the Icon on 
the Operator Login Screen” on page 65.

The home directory and VnmrJ files can be restored from 
the trash can if the trash can has not been deleted.

Restoring a user account

A deleted user account can be restored if the trash can has 
not been emptied.

1 Double- click the Trash Can icon.

The Trash Can window appears.
30 VnmrJ 4.2 Administration Guide



VnmrJ Account Administration 2 
2 Select the account to be restored by clicking on it once.

3 Select Restore.

4 Exit the Trash Can window.

Converting user accounts to VnmrJ

Use this procedure to convert VNMR users to VnmrJ users.

1 Select Configure from the VnmrJ Admin interface.

2 Select Users.

3 Select Convert users.

The Change vnmr users to VnmrJ users window appears. 
VNMR user accounts are listed on the left side of the 
screen.

4 Click an interface type to sort by interface type.

5 Select the VNMR account to be converted.

6 Select the interface type and click the green arrow.

7 Hold the Control and Shift keys to make multiple selections 
of accounts with the same interface.

8 Repeat the previous step for other accounts using other 
interfaces.

9 Click Update Users.
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Updating user accounts

Use this procedure to update multiple VnmrJ user accounts.

1 Select Configure.

2 Select Users.

CAUTION Update user accounts after upgrading or reloading software.
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3 Select Update Users.

The Update VnmrJ Users window appears with VnmrJ 
user accounts listed on the left side of the window.

4 Click an interface to sort by that interface.

5 Select the accounts to be updated.

6 Hold the Control and Shift keys to select multiple accounts 
with the same interface.

7 Click the highlighted, green arrow to move the accounts to 
Update Users.

8 Click Update Users.

Deleting a user account

A user account can be deleted by selecting the user account 
and dragging it to the Trash Can or by using a .csv file. 
Once the Trash Can is emptied, the account cannot be 
restored. 
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Setting User Preferences

Each VnmrJ account can be further customized in the VnmrJ 
program. These preferences control only that user account 
and any operator using that account; it does not affect any 
other VnmrJ account. The Preferences pop- up and all of its 
contents are described in detail in the Agilent VnmrJ 
Familiarization Guide.

• Data saving templates

• Default automation functions

• Day and night queues

• Study Queue display configuration

• Settings for all sample queues

• E- mailing options

• Data mirroring 

• Parameters to preserve during a queued acquisition 
(Sample tags)

• The ability to define parameters to be stored and recalled 
for the user

• Operator rights

• Adaptive NMR

To access the Preferences pop- up, in the main VnmrJ menu 
bar, click Edit > Preferences... The Preferences window appears.
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Templates

Figure 5 Preferences — Templates tab

Preferences found in the Templates tab are usually 
customized to the user’s needs and several common 
examples are provided here (although the default naming 
and saving convention can be used.) Parameters are placed 
between dollar symbols (example: $pslabel$), time and 
date substitutions are placed between percent symbols 
(example: %DATE%), and appending a numeral on the end 
that increments to prevent names from being identical can 
also be added (example: %R3%) in the templates. Entering 
man(‘Svfname’) in the VnmrJ command line will provide a 
detailed description of other substitution identifiers, usage, 
and examples.

NOTE The Study Directory Template is a path. The three remaining templates are 
directories and do not contain a path ("/" forbidden). Any changes done on this 
window should be saved before exiting the pop-up by clicking Save. Changes do 
not affect submitted studies, only future studies. If the Automation Directory 
Template is changed, a new automation run needs to be started for the template 
to become effective. 
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In the example above, all study data is directed to 
/home/vnmr1/vnmrsys/data/<study owner>, accomplished by 
the use of the $studyowner$ argument. The data for each 
sample will further be saved in a directory named 
<notebook>_<page>, where notebook and page are the 
notebook and page numbers that were entered in the Start 
tab of the parameter panel. The actual FID directory will be 
saved as <pslabel>_<samplename> with a three digit revision 
after it.

Other sample templates are shown below:

Figure 6 Fixed text (Book and Page) are included in the Sample Direc-
tory Template
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Figure 7 Date in the format of day-month-year is included in the Sam-
ple Directory Template

Figure 8 Date in the format of numerical year-month-day is included in 
the Study Directory Template
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Queue

The Queue tab offers options for the actual automation 
queue. All settings at this page are default settings. Each 
sample submission will start with these default settings. 
They can be overwritten during the sample submission.

eOptions

Actions that will be taken to produce an electronic output of 
the recorded spectra are defined here. The default options 
set on this tab will be the default option with every new 
study queue. Each operator has the option to override these 
in the Start parameter panel during the submission of the 
queue.

UserPrefs

The UserPrefs tab allows the account administrator to set up 
operator options. The account administrator can define the 
interface personality at the time of operator login from here, 
as well as the action to be taken after sample submission. 

Spinner and temperature configuration

The temperature and spinner control can be set from the 
Start Spin/Temp parameter panel. If “Control … from this 
panel only” is selected, then the configuration on this page 
is applied to all operators and experiments, and can only be 

NOTE The Preferences pop-up and all of its contents are described in detail in the VnmrJ 
Automation User Guide, Chapter 7.
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reset/changed from this panel. If it is unchecked, then users 
may have the option to change the temperature and/or 
regulate spinner as desired.

Temperature can also be set from the Automation section of 
the Preferences pop- up but will not supersede the 
temperature setting in the Spin/Temp panel if “Control 
temperature from this panel only” is selected. 

Figure 9 Spin/Temp panel
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Operator Administration

Administration of operators includes adding or deleting 
operators, resetting operator password, assigning e- mail 
address, panel level, and command line access.

Adding operators to a user account

1 From the VnmrJ Admin interface, select Show all VJ Users 
and select the desired user account.

2 Type the name of each operator in the VnmrJ Operators 
box in the User Profile Panel, separated by a space. 

Operators with no operating system account are assigned 
the default password. Operators with an operating system 
account can use their operating system account login to 
access the VnmrJ operator interface.

3 Click Save User.

Resetting the operator password

This section only applies to operators that do not have an 
operating system login. 

1 Double- click the VnmrJ Admin desktop icon.

2 Click Configure > Operators > Reset Password. The Reset 
Operators’ Password window appears.

3 Enter the operator or operators in VnmrJ Operators. 

4 Click OK.
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Figure 10 Reset Operators’ Password dialog box

Modifying operators

In the Modify Operators pop- up, a system administrator 
assigns operators an email address, a panel level, a full 
name, access to the command line, a profile, and can also 
remove an operator.

Opening the Modify Operators window

1 From the VnmrJ Admin interface, click Configure.

2 Click Operators.

3 Click Edit Operators.

The Modify Operators window appears.
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Figure 11 Modify Operators window

Assigning operators an e-mail address

The operator can be assigned a default email address. If the 
operator's email is added, the operator is notified when a 
sample is finished. 

1 From the VnmrJ Admin interface, click Configure.

2 Click Operators.

3 Click Edit Operators.

The Modify Operators window appears.

4 From the Modify Operators Window, click Modify Operators.

5 Click the Email box to edit.

6 Type or edit the email address.

7 Click OK to accept changes and close the Modify 
Operators window.
42 VnmrJ 4.2 Administration Guide



VnmrJ Account Administration 2 
Setting panel levels and command line access

Panel levels are set by the VnmrJ Administrator and 
determine which VnmrJ interface pages are available under 
the tabs in the parameter page area. Setting panel levels 
applies only to walkup account owners and walkup account 
operators. The default is 10 for operators and 30 for the 
account owner. Setting the panel level higher allows for more 
pages to be available. The experimental VnmrJ account has a 
fixed panel level of 100.

1 From the VnmrJ Admin interface, click Configure.

2 Click Operators.

3 Click Edit Operators.

The Modify Operators window appears.

4 From the Modify Operators Window, click Modify Operators.

5 Change the panel level for any operator by entering a 
value in the Panel Level cell for the operator.

NOTE Panel levels can only be changed during the operator login process in the 
Walkup interface. 
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Panel level values and displayed pages are:

6 Type Yes in the field under Show Command Line to give 
each operator command line access. The default is no 
command line access.

7 Do one of the following:

• Continue to the next section.

• Click OK to close the Modify Operators window.

• Click Cancel to exit the Modify Operators window and 
make no changes.

Adding operators full name

1 From the VnmrJ Admin interface, click Configure.

2 Click Operators.

3 Click Edit Operators.

The Modify Operators window appears.

4 From the Modify Operators Window, click Modify Operators.

Value Display

0-9 Shows minimum number of pages.

10-29 No shim, lock, or processing, and minimal parameter control is 
available. This may be used for routine automation users and is 
typical for a basic user.

Shim and lock are available only if there is a no sample changer. 
Basic processing is available. Pages are not fully populated, 
allowing control of a few basic parameters.

30-49 All pages are available and fully populated. 
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5 Edit or add the full name of the operator in the field 
below Full Name.

6 Do one of the following:

• Click OK to close the Modify Operators window.

• Click Cancel to exit the Modify Operators window and 
make no changes. 

Changing the icon on the Operator Login screen

The default Operator Login window contains the Agilent 
Technologies, Inc. logo, which is a GIF file. Change the logo 
as follows.

1 Select Configure.

2 Select Operators.

3 Select Preferences to display the Preferences window.

4 Enter the complete path to the GIF file.

5 Click OK.
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Deleting operators from a user account

To delete an operator from a single account: 

1 Click the user account from the Users Panel.

The operators of that user are listed in the User Profile 
Panel.

2 Edit the VnmrJ Operators box to remove the operators 
from the list.

3 Click Save User.
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Deleting operators from all assigned accounts

1 Select Configure.

2 Select Operators.

3 Select Delete Operator.

The Modify Operators window appears displaying the Delete 
Operators tab.

4 Select the operators to be removed and click OK.
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User Defaults and Directories

Use the VnmrJ Admin interface to set up user account 
defaults, templates, and directories.

User account defaults

Review and configure user account default properties before 
creating a new user account. These properties apply to all 
new VnmrJ user accounts.

1 Select Configure.

2 Select Users.

3 Select Defaults.

The Defaults window appears and shows the defaults that 
will be used when a new user account is established.

Field Description

Name Full name of a user.

Home Home directory of a user.

Userdir Directory that contains private VnmrJ files for a user.
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4 Review the home field, which shows the path of a new 
user's home directory. 

The default is set to /home/$accname.

The account name is $accname and /home is where the 
home directory of a new user account is located. This path is 
only used if the user is not a defined operating system user. 
The current home directory of existing operating system user 
is used.

Replace /home with the directory path to the user's home 
directory if /home does not exist or if the home directory 
of the user is located in another directory.

5 Review the itype field (the default interface type) for 
new VnmrJ users.

6 Click OK to save your changes or Cancel to leave the 
settings unchanged.

Sysdir System directory for VnmrJ.

Datadir Path of the directories where user data is stored.

Appdir Directory search path used to search for 
application-specific files.

Itype The itype field specifies the user interface. Spectroscopy 
for automation and manual operation systems.

Access User's access level to other users' data

Owned Directories that are owned by the user

Operators Authorized account users. A system login is not required.

Update When creating users, makeuser is automatically run to 
update user preferences if the value is set to Yes. This 
setting is only for operating system or VnmrJ users who are 
already in the system

Field Description
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Viewing the File System

The lower right panel of the VnmrJ Admin interface shows 
information about the operating system.

The Select Directory tab has the following icons:

Instruction/button/icon Description or window

1 Select UNIX.
2 Select File System.
The View Directories window opens.

Disk space window  

Disk space window displays information about mounted network directories, disk partitions, size, space used, space 
available, available capacity. This same information is also shown from Disk Space tab in the VnmrJ 4 Admin Interface.

 Change the directory to selected directory.

 Go to admin's /home directory.

 Create a new directory in the current directory.

 List files with small icons.

 List files with small icons and details.

Look In drop-down menu Select a directory from the drop-down list. Click a directory in the directories window to 
select a directory. The directory is inserted in the empty directory field of user directories. 
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Persona Manager

Use the Persona Manager to customize user preferences, 
permissions, user types (persona), and create users from the 
current VnmrJ login account. 

There are two levels of persona in VnmrJ:

• The Administrator can create persona and assign them to 
Users. This is done using Edit > System Settings > Persona 
Manager. This option is only available if you are a VnmrJ 
system administrator. The Persona Manager for VnmrJ 
system administrators is shown in Figure 12 on page 55. 

• The Administrator or User can assign persona to 
Operators. This is done using Tools > Persona Manager.

The Persona Manager window has three panels: Widgets and 
Rights, Parameter Panels, and Protocols. 
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Figure 12 Persona Manager for VnmrJ system administrators
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Persona Manager - Administration

Use the Persona Manager Administration tools to create and 
assign persona to Users (if you are a VnmrJ system 
administrator) or Operators (if you are a VnmrJ system 
administrator or User). 

Figure 13 Persona Manager — Administration 

Persona

VnmrJ comes with four predefined user types, called 
“persona”. Owner has all permissions and no restrictions, 
and the other three have increasingly limited access. 

• Owner

• Spectroscopist

• Chemist

• Student 

These user types have been provided as examples or 
templates for easy customization. 
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Creating a new persona

To create a new persona:

1 Configure settings appropriately.

2 Enter the new persona type in Save changes as: and click 
Save.  
The persona types are stored in the directory 
/vnmr/personalib. User types can be assigned to an 
operator by selecting the appropriate name from the 
Operator pull- down list. 

3 Select the persona type from New Persona pull- down and 
click Assign.  
The operator will then be assigned the preferences and 
privileges of that persona after the next login. 

Managing a Large Numbers of Users

When managing large numbers of users, it may be easier to 
assign persona types directly from the file 
vnmrsys/persistence/PersonaManager/PERSONAassignment. 
This is simply a text file with a two column list containing 
operator names in the first column and the persona type 
assigned in the second. This file can be edited with a text 
editor, or generated from an excel file as tab-  or 
space- delimited text and placed in the appropriate directory. 
Alternatively, the file could exist on a central server with 
pointers to it. This allows for easy management of users on 
multiple instruments. 

NOTE The default persona is “Owner,” and includes all privileges. Owner is 
assigned if the type was not defined or a type name has been assigned 
that does not exist.
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Persona Manager - Preferences

The Preferences panel contains a subset of preferences that 
can be applied on a per- user basis. For example, inputs to 
manage the limits for experiment time and priority samples, 
queue submission controls, and instructions for after login 
and/or sample submission. These preferences can be applied 
to a specific user or user type. General preferences, such as 
sample change time and automation directories, should be 
managed from Edit > Preferences. 

Figure 14 Persona Manager — Preferences
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Persona Manager - Widgets and Rights

The Widgets and Rights panel contains lists of menus, tools, 
vertical panels, and rights. Accesses are granted from the 
check box to the left of each item. This list allows for a 
great deal of flexibility to manage user privileges. 

Figure 15 Persona Manager — Widgets and Rights
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Persona Manager - Parameter Panels

Use Parameter Panels to control access to the parameter 
panels beneath the spectrum window. 

Figure 16 Persona Manager — Parameter Panels
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Persona Manager - Protocols

The Protocols panel is where access to experiments in the 
Experiment Selector can be managed. Access can be 
managed either by individual experiments, or by entire 
protocol groups or subgroups. At the top of the panel are 
pull- down menus to view the four different experiment 
protocol groups and the subgroups. Next to the pull- down 
menus are check boxes to allow or restrict access to the 
entire group or subgroup currently selected. Below these 
menus, each experiment for the current group/subgroup 
selected is listed and access to the individual protocols can 
be controlled from the check box to the left of the 
experiment name. 

Figure 17 Persona Manager — Protocols

NOTE Custom protocols will automatically appear in the list. All users and user types 
will be granted access to newly created protocols. 
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Configuring Probe Files

A probe file contains a list of parameters that change with 
each probe: pulse widths, powers, decoupling patterns or 
shapes for proton, carbon and other nuclei (if applicable). 
The probe files are maintained in either local directories or 
globally in the probes directory of /vnmr. Users may have a 
local probe file (vnmrsys/probes) that they keep current 
with the latest calibrations and gradient shimming files. The 
global probe file is maintained by the administrator. A probe 
file that corresponds to the installed probe must be selected 
for proper functioning of protocols within VnmrJ.

Setting up, selecting, and creating a probe calibration file

Create a probe calibration file before calibrating a probe for 
the first time, using the procedure described below.

1 Click the Probe button in the hardware bar of the VnmrJ 
4 interface.

The probe selection window appears. (See Figure 18 on 
page 65.)
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2 In the Manage Probe Files section of the probe pop- up 
window, type the new probe name into the field for Probe 
name (letters first, followed by numbers and no spaces, 
e.g. abc456) and press the Return key.

3 From the Probe ID pull- down menu choose either Probe 
without ID to create a blank probe file or choose the probe 
ID that corresponds to the desired probe. This creates a 
probe file that is pre- populated with approximate 
calibration values for that style of probe.

Figure 18 Probe window
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4 Do one of the following based upon the operating system 
login:

• VnmrJ administrator or user with equivalent write 
permissions – select the appropriate radio button to 
choose either: 
Systemdir— writes the calibrations into: 
/vnmr/probes/probe_name 
and makes all calibration available to all users — typical 
for new system and probe installation. 
– OR – 
Userdir — writes the calibrations into: 
~/vnmrsys/probes/probe_name 
and is available only to the logged in user creating the 
calibration file. 
The User level calibration file can be written to the 
system level directory, if the user has write permission 
to the system level directory, by entering the desired 
file name and clicking Copy. See Figure 18 on page 65.

• Logged in as a user (most users) without write 
permission to /vnmr/probes files — continue with the 
next step. The Level option is not displayed and all 
calibrations will automatically be saved to 
~/vnmrsys/probes/probe_name.

5 Click the Create button.

a Do the following for nano and AutoMAS probes:

Enter tach in the field next to Probespintype 
(do not use the nano option).

Enter an approximate maximum spinning speed based 
on the probe: 
Nano probe — 2500 is typical 
MAS probes — Maximum value for the spinner that will 
be used most often. Refer to the probe manual for 
specifications of spinner speed, material, and 
temperature.

Update the parameters after adding an MAS type probe 
by entering probe=probe on the VnmrJ command line. 
Selecting the new MAS type probe will now 
automatically set the spintype and the maximum speed. 
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The Spin/Temp panel will require updating if it was 
open while the new probe was added. Select any other 
panel then select the Spin/Temp panel.

b Run a calibration. See “Starting a calibration in 
Experiment Selector” section in the Agilent VnmrJ 
System Calibrations Guide. 

For an existing probe

a Select the probe from the drop- down menu.

If this probe file was NOT created from VnmrJ, then 
the probefile should be updated so that it will contain 
additional parameters for use in VnmrJ. Take note of 
the lock power and lock gain values stored in the probe 
file.

Click Edit, then click the lk tab in the Probe edit 
window, then from the command line type 
updateprobe to update the probe. Then, re- enter the 
lock power and gain values for the various solvents in 
the probe file.

b Run a calibration. See “Starting a calibration in 
Experiment Selector” section in the Agilent VnmrJ 
System Calibrations Guide.

NOTE The new/updated probefile will contain the parameters Probewtune 
and Probetunemethod. If the probe is a ProTune-compatible probe, 
these parameters should be set for the desired operation. The directory 
/vnmr/tune/methods contains the entries valid for 
Probetunemethod. The parameter Probewtune takes the same 
parameters and has the same usage as the parameter wtune. (See the 
Command and Parameter Reference entry for wtune.)
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Adjusting solvent lock power and gain values in the probe file

The solvent lock power and gain values are written to the 
probe file the first time a gradient shim map is 
automatically generated. The values are based are based on 
the lock power and gain values of the D2O sample used. 
These values should be adjusted for typical samples used in 
the probe after the automated routine has been run, so as to 
not replace your manually adjusted values for calculated 
values.

1 Log in as the VnmrJ administrator.

2 Double- click the VnmrJ desktop icon.

3 Click Probe at the bottom of the VnmrJ interface. The 
Probe window appears. 

The Current probe and Manage probe files sections 
display pull down menus of probes available for showing 
and editing. 

4 Select the probe to edit from the appropriate section from 
the pull down menu.

5 Click either the Edit/Show Probefile if editing the current 
probe displayed in the pull down menu or Edit if editing a 
probe in the Manage probe files section. The probe file is 
displayed.

6 Click the lk tab to display and edit the lock power and 
gain values of various solvents under automation.

7 Scroll to the bottom of the page and click Save Changes to 
accept changes.

8 Click the Close button to close the Probe edit window.

9 Click the Close button to close the Probe window.

NOTE If the autocalibration routine for gmap and z0 is run, the new/updated probe file 
will contain calculated values of lock power and gain. A backup of the old profile 
file with previous values is located in the probe’s directory.
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Adding and removing a nucleus in the probe file

A new entry (example: Si29) can be added to the probe file 
by typing on the command line:

addnucleus(‘Si29’)

The probe file will then need to be edited to contain 
appropriate values for the new entry. Follow the directions 
in the “Adjusting solvent lock power and gain values in the 
probe file” on page 68, except click the Si29 tab rather than 
the lk tab.

Alternatively, a new entry can be added by scrolling to the 
bottom of an opened probe file, then entering the nucleus in 
the Nucleus box and clicking Add.

Figure 19 Adding nucleus in an opened probe file

NOTE The Save Changes button is located at the bottom of every tab. If it is not 
visible, then scroll down to the bottom of the displayed tab.
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Configuring Printers    72

Setting Up a Printer for VnmrJ    74

To configure printers for VnmrJ, first set up the printer in 
Linux using standard Linux system tools. Then use the Vnmr 
Plotter Configuration window to add or configure a printer 
for VnmrJ. 

NOTE Adding or managing a printer is done by the Linux or VnmrJ administrator.
71
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Configuring Printers

The general steps to add and manage printers are:

1 Ensure the printer is connected and powered on. 

2 Use the Linux desktop tools (with root permission) to 
find and create the printer.   

3 Use VnmrJ Admin (as vnmr1) to set the printer up for 
VnmrJ. 

4 Each user must select the printer from their account 
using the File- >Printers menu in VnmrJ

Setting up a Linux printer

Follow this procedure for each printer to be accessible by 
VnmrJ.

1 Click on the Linux System menu.

2 Select Administration.

3 Select Printing.

4 Enter the root password in the pop- up window. The 
Printer configuration window appears. 

5 Click New > Printer in the Printer configuration window.

A New Printer wizard is displayed to assist in adding a 
Printer. Follow the wizard to completion.

6 Print a test page from the printer configuration window 
to verify proper configuration of the printer.

NOTE If the correct print driver is not in the list of pre-installed drivers, then selecting 
one of the same manufacture and model/style will usually work. VnmrJ writes 
PostScript or PCL print files.
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NOTE Printers may also be managed from the Common UNIX Printing System (CUPS) 
interface accessed by going to http://localhost:631 in a browser.   More 
information can be found by visiting the official CUPS web site. 
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Setting Up a Printer for VnmrJ

Set up a VnmrJ printer using the VNMR Plotter 
Configuration window.

1 Click the VnmrJ Admin icon.

2 Click Management.

3 Select Printers... to open the VNMR Plotter Configuration 
window. 
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4 Select an available printer from the Linux Printer Name 
pull- down menu. 

5 Enter in a Name that VnmrJ will use to recognize this 
printer in the VNMR Device Name entry window. 

6 Configure VnmrJ page settings on the right of the VNMR 
Plotter Configuration window: paper size, output format, 
dots per inch (dpi), paper orientation, and printable area. 

7 Click Close to save and close the VNMR Plotter 
Configuration. To abandon all changes, click Abandon. 

8 To delete a printer, select the printer in the VNMR Device 
Name column.

9 Click Delete selected, then click Close to save the deletion 
and close the VnmrJ Plotter Configuration window.

Setting printers for users

Each user will need to set their default printer and plotter 
from the list created in the Plotter Configuration window in 
their own account in order to print from VnmrJ. 

1 Double- click the VnmrJ desktop icon.

2 In the VnmrJ menu bar, click File > Printers. The Plotter 
Configuration window appears.

NOTE The Reset to default button resets the printer configuration to the last 
saved settings. It does not restore the settings to a “factory default.”

NOTE Creating plots with resolution of 1200 dpi and above will usually result in 
plot lines that are too fine or too light for presentation-quality results.

NOTE Refer to the original manuals supplied with the printer or refer to online 
manuals for printers with older spectrometers.
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3 Select a default printer and plotter to be used then click 
Close to save the setting.

Figure 20 Configuring printers in VnmrJ
76 VnmrJ 4.2 Administration Guide



Agilent  VnmrJ 4
Administration Guide
6
VnmrJ Automated Hardware 
Administration

Setting Up Automated Sample Handling    78

Setting Up Automatic Probe Tuning    79

This section describes how to configure software to control 
automated hardware.

Setup procedures require administrator access. 
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Setting Up Automated Sample Handling

1 Log in as the administrator.

2 Click Edit on the main menu.

3 Select System settings.

4 Click the System config button.

5 Click the drop-down menu next to the Sample Changer 
field and select a sample changer option.

6 Click the drop-down menu next to the Sample Changer 
Port field.

7 Select a sample changer port.

8 Click the drop- down menu next to the Sample Changer 
Port field.

Operating and other instructions specific to an automated 
sample handing option are contained in the Automation 
manual and their corresponding hardware manuals.

9 Click OK.

SMS 50, SMS 100, Carousel, VAST Select Com1

Not used or no sample handler None
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Setting Up Automatic Probe Tuning

Use the procedures in this section to set up automated 
probe tuning.

Configuring the Software for ProTune

1 Log in as the administrator.

2 Click Edit on the main menu.

3 Select System Settings.

4 Click the System config button.

5 Select Present from the drop- down menu next to the 
Automatic Probe Tuning field.

6 Click OK.

7 Continue with “Loading chan# and motor# Persistence 
Files”.
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Loading chan# and motor# Persistence Files

AutoX- compatible probes ship with a CD or are on a 
probeID containing Persistence files (chan# and motor# 
files) specific to that probe. These files characterize the 
probe for the Automatic probe tuning accessory and are 
used the first time the probe is automatically tuned. 

To load the Persistence files from a CD:

1 Insert the CD with probe Persistence files into the CD 
ROM drive.

2 Open a terminal window and do one of the following:

Locate the system probe file.

a Type: 
cd /vnmr/probes  
ls 

b Write down the <name of probe file>.

c Continue with step 3. 
If no probe file exists, follow the procedure for setting 
up, selecting and creating a probe calibration file in the 
VnmrJ 4 NMR System Calibrations User Guide.

d Type:  
cd /vnmr/probes  
ls 

e Verify and write down the <name of probe file>.

f Continue with step 3.

3 Type:

cd /vnmr/tune  
mkdir <name of probe file>

4 Type: 

cd /media/cdrecorder 

5 Copy the Persistence files from the CDROM to the created 
probe directory: 

Type: cp * /vnmr/tune/<name of probe file> 

6 Verify that the files were copied.
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Type: ls /vnmr/tune/<name of probe file> 

The new ProbeName directory should contain six chan# 
files (chan#0 through chan#5) and six motor# files 
(motor#0 through motor#5) for standard AutoX and 
OneNMR probes. 

To load the Persistence files from probeID:

Install and enforce probe ID. If probeID will not be used, 
copy the persistence files from 
/vnmr/probeid/cache/<ID>/Varian/Tune be file> 

to 

/vnmr/tune/<name of probefile> then disable probeID. 
See steps 1- 3 and 5 from “Loading chan# and motor# 
Persistence Files” on page 80 to create and copy the 
persistence files.

ProTune software copies the probe Persistence files to the 
directory ~user/vnmrsys/tune the first time it is run by a 
user. If the directory has not been created, the directory is 
created. A database of reference values is maintained in the 
local directory.
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Configuring Default Tuning Parameters for Autotuning in 
Automation

1 Click Probe in the Hardware Toolbar > Edit/Show Probefile. 

2 Recommended parameters for OneNMR and AutoX probes: 

• Probewtune = st12

• Probetunemethod = lohi

For more information about these parameters, see the User 
Programming Guide and the Command and Parameter 
Reference Guide. 

Figure 21 Probe Edit window
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reports.
83
Agilent Technologies



7 VnmrJ Accounting Administration 
 

Starting VnmrJ Accounting

VnmrJ Accounting is managed from within a separate user 
interface in VnmrJ Admin. 

To open the VnmrJ Accounting interface

1 Log in as the administrator.

2 Start VnmrJ Admin. 

3 In the menu bar, click Management.

4 Select Cost/Time Accounting.

To enable record keeping

In order to activate record keeping, 

1 Open the VnmrJ Accounting interface. (See “To open the 
VnmrJ Accounting interface”.)

2 In the VnmrJ Accounting interface, click the Properties tab. 

3 Under Record keeping, click to select the check box next 
to Acquisition & Use record keeping. When selected, the label 
on the check box changes from Inactive to Active 
(Figure 22 on page 85).

NOTE In order to do cost and time accounting, you must first 
enable the record keeping log. (See “To enable record keeping”.) 
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Figure 22 Enable record keeping in VnmrJ Accounting
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VnmrJ Accounting Window Interface

The VnmrJ Accounting interface contains three tabs, where 
you set up Billing, Accounts, and Properties.

Billing 

Click the Billing tab in the VnmrJ Accounting window to 
open the Billing window. See Figure 23. See also “Generating 
Invoices” on page 89.

Figure 23 VnmrJ Accounting Billing tab

Default logo or optional customer logo

Calendars are used
to select start and
end dates for 
generating invoice

Invoice details for selected dates
is displayed in this area when you 
click Display this invoice.

Billing address
of selected account

Select account
from drop-down list

Options for printing
invoices
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Accounts 

Click the Accounts tab in the VnmrJ Accounting window to 
open the Accounts window; see Figure 24. See also “Creating 
or Editing an Account” on page 90 and “Establishing or 
Editing a Billing Rate Schedule” on page 92.

Figure 24 VnmrJ Accounting Accounts tab

Default logo or optional customer logo

Click Save to save information or changes to selected account

Type new account
or select from drop-
down menu

Billing address
of selected account

Rate schedule
for access and
hourly usage 
charges

List of VnmrJ 
owners and 
operators.
Select to add to
owner or operator
to billing account

Click to remove selected account

Invoice layout for detailing charges
appears here
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Properties

Click the Properties tab of the VnmrJ Accounting window to 
open the Properties window; see Figure 25. See also 
“Controlling Properties” on page 95.

Figure 25 VnmrJ Accounting Properties tab

Default logo or optional customer logo

Billing address

Select to enable
records keeping

Select a date and
click Cut Records
to remove records
prior to selected
date

Select currency

Use default logo
or browse to 
select custom
logo

Select billing
mode

Customize 
rate schedule
table headers
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Generating Invoices

1 Start the VnmrJ Accounting interface if it is not running 
(“Starting VnmrJ Accounting” on page 84).

2 Select the Billing tab.

3 Select an account number from the drop- down list of 
accounts in the Account: field.

4 Select the start day using the Start Date: calendar controls 
as follows:

a Select a month and year using the calendar controls.

b Select a date by clicking on the calendar date in the 
selected month and year.

5 Select the end day using the End Date: calendar controls 
as in step 4.

6 Do one of the following:

Print Invoice for currently displayed account

a Click the Display this invoice button to display the invoice 
on the right side of the Billing tab; see Figure 23 on 
page 86.

b Click Print this invoice to print the displayed invoice.

Print invoices for all accounts on system

a Click Print all invoices to generate an invoice for each 
account on the system.

b Click Print Summary button to print out the summary 
page. The summary can be saved as a comma separated 
value (.csv) file for use with other software.
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Creating or Editing an Account

A billing account gathers the time and use charges for 
system login account owners and any operators with 
privileges to use the system login account.

1 Create any required system login accounts that are 
required, see “User Account Administration” on page 21.

2 Add any required operators to each system login in 
account; see “Creating Profiles- Spectroscopy Accounts” on 
page 54.
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3 Start VnmrJ Accounting, see “Starting VnmrJ 
Accounting” on page 84.

4 Select the Accounts tab.

5 Enter an account name in the Account field in the Account 
region or select an existing account number from the 
drop- down menu.

Account name can be alphanumeric, a combination, and 
can contain dashes or underlines. Do not use spaces, 
special characters, or non printing characters. Any string 
that is a legal filename may be used.

6 Complete the Billing address information work sheet for a 
new account or edit the information as required to update 
of an existing account.

7 Create or edit the billing rate, see “Establishing or Editing 
a Billing Rate Schedule” on page 92. 
Add owners and operators whose usage is tracked and 
billed to this new account by selecting the check box next 
to the owner or operator.

8 Click Save to save the new or updated account 
information.
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Establishing or Editing a Billing Rate Schedule

Use the Accounts tab to create and edit a billing rate 
schedule. See “Billing rates” on page 92 and “Billing rates 
example” on page 94.

Billing rates

Usage is billed at the sum of the hourly rate times the 
number of hours plus the login or go rate charge.

The rate schedule for the current account is shown in the 
Rate schedule region. A new account will have only one 
billing row. An existing account will have one or more billing 
rows.

1 Enter account values for: Set the day, time, login rate, and 
hourly rate (Login billing default) or set the day, time, Go 
rate, Go hourly rate (Acquisition billing default) by using 
the control to set the required value or enter the 
information into the fields.
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2 Insert or delete rows as required.

To insert a new row:

a Place the cursor in any field of the row below which a 
new row is required.

b Click the Insert Row button to add a row below the row 
with the cursor.

To delete a row:

a Place the cursor in any field of the row to be deleted.

b Click the Delete Row button to delete the row.

3 Click the Save button to save the new rate schedule for 
the current account.
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Billing rates example

The billing period and rate begins on the day specified in 
the Day field at the time specified in the Time field and 
continues at the specified rate until a new time (on the 
same day) or new time and day are encountered. The rate of 
the last row applies until the time specified in the first row.

Set up a weekday/weekend schedule as follows:

1 Set the day on the first row to Mon.

2 Set the Time to 06:00 (6 AM). Change the hours using up 
and down arrows by double- clicking on the hours first. 
Change the minutes using up and down arrows by 
double- clicking on the minutes first. The time can also be 
entered.

3 Set a Rate for Login or Go.

4 Set the hourly rate.

5 Add a new row below the current row.

6 Set the day on the new row to Sat.

7 Set a new time of 00:01 (12:01 AM Saturday morning).

8 Set a new Rate.

9 Set a new hourly rate.

The weekday rate in this example begins at 06:00 hours on 
Monday and continues until one minute past midnight on 
Friday or 00:01 hours Saturday morning. The weekend rate 
continues until 06:00 hours Monday morning when the 
weekday rate starts.
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Controlling Properties

Properties apply to all system accounts. Use the Properties 
tab of the VnmrJ Accounting window to Enable/disable 
record keeping, Reduce record size, and set Invoice 
Properties.

Enable/disable record keeping

To enable record keeping, 

1 From VnmrJ Administration, select Management > Cost/Time 
Accounting.

2 In the VnmrJ Accounting window, select the Properties tab.

3 In Record keeping, make sure the check box next to 
Acquisition & Use record keeping is selected.

The label changes from inactive or on hold to active when 
the check box is selected.

4 From a terminal, type the command su acqproc twice if 
the Acquisition record keeping is (re)activated.

When record keeping is enabled, a log file is created 
/vnmr/adm/accounting/acctLog.xml. Login/Logout and 
Acquisition (go) record logging are both entered in this file.

Parameters that are automatically logged:

type (login/logout/gorecords), start, startsec, 
end, endsec, operator, owner, seqfil (for 
gorecords only), systemname, vnmraddr

To have other vnmr parameters included in the log files, the 
vnmrj admin can add parameters to the file 
/vnmr/adm/accounting/loggingParamList.

NOTE If the acctLog.xml file does not exist, no logging will take place. This 
log file is in XML format with date and time in easy to read format.
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Entries should be in two columns where the first column is 
the parameter name and the second column is the "tree" 
where the parameter is located.

For example:

    # paramName   tree

      tn          current

      sw          current

This example adds the nucleus and sweep width to the log 
file. Some parameters will not make much sense for 
login/logout nor others for acquisition. However, the 
parameters will be dutifully logged as requested in this 
configuration file.

Reduce record size

The accounting record files can be large over time. To reduce 
their size:

1 Select a month and year using the calendar controls.

2 Select a date by clicking on the calendar date in the 
selected month and year.

3 Select Logout records or Acquisition records.

4 Click the Cut Records button.
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Invoice Properties

Invoice properties are set on the Properties tab.

Locale

Enter a two letter local code in the Locale field to establish 
the billing currency correct currency format. Local codes and 
currency formats are available at: 
http://www.chemie.fu-berlin.de/diverse/doc/ISO_3166.html

Logo

Keep the default Agilent logo or select a custom logo using 
the Browse button. Place any custom logo in 
/vnmr/adm/accounting/ as .gif files. The default logo 
is 87x70 pixels. The logo does not have a size limit and the 
invoice layout can adjust to accommodate logo size.
VnmrJ 4.2 Administration Guide 97



7 VnmrJ Accounting Administration 
 

Billing modes

Account billing is determined by one of two billing modes: 
Acquisition Time, VnmrJ Use.

Acquisition Time

Tracks the time from start to completion and processing of 
an experiment. This is tracked in: 
/vnmr/adm/accounting/acctLog.xml.

VnmrJ Use

Tracks the time the owner or operator starts or logs into 
VnmrJ. This implementation is used to track operator time 
during walkup, owner time in walkup or experimental mode, 
or both. If more than one VnmrJ 4 is opened, both are 
tracked and invoiced. This is tracked in: 
/vnmr/adm/accounting/acctLog.xml. This is the only 
method to track operator time. This was previously referred 
to as Login or Logout Use.
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File Locations

• Account information —

/vnmr/adm/accounting/accounts/<account>.txt

• Records —

/vnmr/adm/accounting/acctLog.xml

• Logo —

/vmnr/adm/accounting/*.gif 

• Properties file —

/vnmr/adm/accounting/accounts/accounting.prop

• Logging parameters

/vnmr/adm/accounting/loggingParamList

NOTE Gorecords and login/logout are both in the acctLog.xml file.
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Properties File Contents

The /vnmr/adm/accounting/accounts/accounting.prop 
file contains the properties and keyword- value pairs 
required to customize the accounting software. Use the 
controls under the Properties tab to maintain this file. Each 
keyword- value pair appears on a separate line and is 
formatted as: 
keyword<space>=<space>value 
Lines starting with the # character are treated as a 
comment and ignored.

Currency

Enter the two- letter name for the country (for example, us 
for United States, de for Germany) to set the number format 
and currency symbol for the local. Refer to the following 
Website for a complete list: 
http://www.chemie.fu- berlin.de/diverse/doc/ISO_3166.html. 
The currency keyword defines currency symbol used in the 
invoice Amount Due and determines the use of the decimal 
period or comma in numbers.

Billing mode

Account billing is determined by one of two billing modes: 
Acquisition Time or VnmrJ Use.

billingmode = macros

Time is tracked by the operatorlogin and 
operatorlogout macros. When the file 
/vnmr/adm/accounting/macrorecords exists, these macros 
will record one line for each login and logout. The file is in 
ASCII and has world read/write permissions.

billingmode = goes
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Time is tracked for any su, go, ga, au, shim, lock, 
spin, change, or sample command. One data line is 
written for each acquisition when the file 
/vnmr/adm/accounting/acctLog.xml 
exists and the following are recorded:

• account — usually "vnmr1"

• operator — the operator name

• goflag — whether su, go, au, etc.

• result — ""

• seqfil — the name of the pulse sequence

• submit — time of submit action

• start — time the acquisition started

• done — time the acquisition stopped, including data 
handling, plotting, etc.

The difference between the last two dates is invoiced.

Table header

Enter table headers. For example:

• If billingmode = goes,

Use tableheaders = "Day" "Time" "Go Rate" 
"Go/hr"

• If billingmode = macros or login,

Use tableheaders = "Day" "Time" "Login Rate" 
"Rate/hr"
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Error Messages

Possible messages in VnmrJ Accounting include Messages 
displayed at start up and Account information error 
message.

Messages displayed at start up

The software checks if certain items exist at start up and 
displays error messages if a required item is missing. Only 
some of the error messages are shown in this section.

If the item exists, the message is as follows:

Other messages that are displayed:

• Environment parameter vnmrsystem or 
vnmrsystem_win not defined.

• In Linux, this parameter is normally defined in the 
.login or .cshrc file using the line: setenv 
vnmrsystem /vnmr

• The line must be added to the .login or .cshrc file 
when VnmrJ accounting is run by an operating system 
login (local or remote) account that was not created by 
VnmrJ Admin. 

• Cannot find the nulladm/accounting/accounts 
directory, please create.
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• This is the directory where the accounts' information is 
stored. It must exist for the software to store and retrieve 
the information. In this example, the path starts with null 
because vnmrsystem or vnmrsystem_win was not 
defined either. The correct directory path is 
/vnmr/adm/accounting/accounts. 
Create the path manually if it is not present.

• Cannot find the 'nulladm/accounts/accounting.prop' 
file, reinstall software.

• The software needs the properties file to determine logos, 
currency, and billing mode. The path starts with null, 
because vnmrsystem was not defined. The correct file 
path is /vnmr/adm/accounts/accounting.prop. 
Reinstalling the software is the method to recover this 
file, unless you can copy it from another place. The file is 
installed with the VnmrJ 4 software.

Account information error message

Times in the rate table must be in chronological order to 
generate accurate and correct invoices. The software checks 
that the times in the rate table are in chronological order 
when the Save button in the account panel is pressed.  

A warning message is displayed if the rate table is not in 
chronological order.

Do one of the following:

• Click the Cancel button, correct the order, and click the 
Save button.
VnmrJ 4.2 Administration Guide 103



7 VnmrJ Accounting Administration 
 

• Continue with clicking on the Save button — the invoices 
may not be correct. The software searches for the first 
entry beyond a login or go time. If the entries are not in 
chronological order the wrong entry may be used.

Comma separated value (or comma delimited)

Write the printer output to a CSV text file for an individual 
invoice or all invoices. This file can be imported into an 
Excel spreadsheet for further processing.

Create the following file to write the printer output to a CSV 
file:

/vnmr/adm/accounting/account/CSV_yes

The file can be a file or directory. Create this file on Linux 
using:

vnmr1>cd /vnmr/adm/accounting/accounts

vnmr1>touch CSV_yes

Return to normal printing by renaming the file to CSV_no or 
by deleting the CSV_yes file.
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Accounting Limitations

• VnmrJ Accounting is only run on systems that create 
billing records. Records are created and invoices 
generated by the VnmrJ Accounting package running on 
the system where the VnmrJ software is installed. 
Accounts are invoiced by the system. A billing account on 
multiple systems will have an invoice for each system. 
Merging records from different systems is not supported.

• Pruning large record files is supported.

• The files /vnmr/adm/accounting/acctLog.xml and 
/vnmr/adm/tmp/macrorecords grow larger and larger 
with time. The VnmrJ 4 Administrator must periodically 
delete records in these files. The acctLog.xml file grows 
the fastest. Use the Properties tab and the Cut Records 
button to reduce the file size or use any ASCII editor to 
delete records.

• Billing modes of Acquisition (goes) and Login (macros) are 
mutually exclusive. Records for both billing methods can 
be kept at the same time. Invoices are written based on 
one or the other mode. Create an invoice using one mode 
then change the billing mode and create a second invoice 
in the other mode.

• Expproc writes the acctLog.xml file. Access permission 
for this file is rw- - - - - - - . Expproc executes with root 
permission and does not need general access permission 
to write to acctLog.xml, making it more secure.
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Converting Log Files to CSV

You can export the login/logout and acquisition log files to 
CSV (Comma Separated Values) format. This enables you to 
import the CSV file into excel or access for further 
manipulation and display. 

To convert the log files to CSV (Comma Separated Values)

1 Open VnmrJ Admin.

2 On the menu, click Management > Export Log to CSV.

The Log to CSV Conversion pop- up appears.

3 On the Start Date and End Data calendars, select start 
and end date (inclusive) for the log data to export. Only 
entries within that date range are converted.

4 Under Parameters to Include, select the parameters that you 
want transferred to the output file.

5 Select Acquisition Records, Login Records or both to be 
converted.

6 Browse to select an output file location and filename.

7 Click Convert.

Figure 26 Log to CSV Conversion pop-up
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Using the xmlToCsv command

The xmlToCsv command can be used by scripts and 
automated cronjobs for the conversion of the login/logout 
and acquisition log files to Comma Separated Values (CSV) 
files. The intent is to allow the user to then import the CSV 
file into excel or access for further manipulation and 
display. It allows for limiting the conversion to 

     specific date ranges

     specific parameters

     acquisition/login/both entries

Usage: xmlToCsv inputLogFilePath outputCsvPath 

[-type acq/login/all] [-paramlist p1 p2 p3 
p4 ...]

[-startdate "Month Date Year"] 

[-enddate "Month Date Year"]

[-debug]

• type can have values of "acq", "login", or "all".

• paramlist should be followed by a space separate list of 
parameters that are desired in the csv file.

• startdate specifies the beginning of the date range to 
be included in the output file. The dates must be in the 
form "Month Date Year" and surrounded by double quotes.

• enddate specifies the end of the date range to be 
included in the output file. The dates must be in the form 
"Month Date Year" and surrounded by double quotes.

• debug Causes the command to output all of the values it 
will be operating with. It is basically a verbose output to 
the command line.
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Liquids

Account-Owner, account-administrator or user 

Account- owner, administrator or user is the user that owns 
the operating system login account. User privileges include 
access to the command line, all parameter panels and all 
protocols, and right to create new or edit protocols for 
operator use. The user (account owner) is the head of a 
group of operators that share the particular login account. 
User responsibilities include maintaining special protocols 
and probe files for this group of operators.

Acqlog

The acqlog file (in /vnmr/tmp) allows the spectroscopist to 
monitor an automation run as it progresses in background. 
The acqlog is a simple text file that (if it exists) is updated 
automatically as a study is submitted to the acquisition 
queue or Study Queue.

Application directory

VnmrJ application directories are directories where VnmrJ 
looks for directories such as templates, maclib, 
manual, menulib, parlib, probes, seqlib, shims, 
tablib, shapelib, gshimlib, and mollib. These are 
directories that VnmrJ 4 uses during its normal operation.
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Application type

Application types (apptype) define how related experiments 
or a family of experiments, are set up, acquired, processed 
and plotted.

Background acquisition

A background VnmrJ process is spawned for this acquisition 
when one or more experiments are submitted for acquisition 
from the Study Queue if background or automation is 
selected. All workspaces are available for data analysis while 
VnmrJ collects NMR data in a background process.

DayQ

The DayQ is typically between the hours of 8:00 a.m. and 
6:00 p.m. and provides 30 minutes of NMR time for each 
sample submitted by the operator. Submitted samples are 
accepted to the DayQ provided the sample data acquisition 
time does not exceed the time limit. See also NightQ.

Direct acquisition 

Direct acquisition is carried out as a foreground acquisition 
and the Study Queue is not used. Select an experiment/ 
protocol from the vertical experiment panel in direct 
acquisition mode or from the list of experiments accessed by 
clicking Experiments on main menu. Parameters are loaded 
directly into the current workspace for manual data 
acquisition.
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Experiment

See “Workspace” on page 117.

File types

NMR data sets have the file extension .fid. The .fid file (FID 
free induction decay data) contains all of the raw data and 
parameters of an acquired data set.

A parameter file or set has the .par extension and contains 
the parameters necessary to set up and acquire an NMR 
experiment. Parameter files may be both local and global. 

A shim file contains a list of shims and their values. Both 
.fid directories and .par directories contain a file called 
procpar, which includes the shim settings.

Foreground acquisition

When working in direct acquisition mode, the workspace is 
tied to a particular manual acquisition. No other NMR data 
set may be loaded into the active workspace while data 
acquisition is in progress.

Minimize spectral window

The minsw (minimize spectral window) process is often 
executed before a 2D experiment. First a full spectral width 
1d is acquired. The software detects where the highest and 
lowest field peaks are, recalculates the spectral width, and 
reacquires the 1d experiment with the new spectral width. 
The minsw process is automatically turned on if a proton, 
preset, or wet1d protocol precedes a 2D protocol.
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NightQ

The NightQ is typically between the hours of 6:01 p.m. to 
7:59 a.m. and provides 3 hours of NMR time for each sample 
submitted by the operator. Submitted samples are accepted 
to the nightQ provided the sample data acquisition time does 
not exceed the nightQ time limit. See also DayQ.

Operator

The administrator creates operators as subservient users of 
a particular user's account. The operator does not own the 
login account. The operator may be considered a 
spectroscopist within a group where the group's head owns 
the login account. The operator privileges such as limited 
access to parameter panels (panellevel), command line, or 
NMR experiments are defined by the VnmrJ administrator.

Panel level

The VnmrJ parameter, panellevel, defines the number of 
pages an operator has access to in the horizontal panels. 
The VnmrJ administrator determines the panellevel for each 
operator.
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Probe file

A probe file is a list of parameters that change with each 
probe: pulse widths, powers, decoupling patterns or shapes 
for proton, carbon and other nuclei (if applicable). The 
probe files are maintained in either local directories or 
globally in the probes directory of /vnmr. Users have a local 
probe file (vnmrsys/probes) that they keep current with the 
latest calibrations and gradient shimming files. The global 
probe file is maintained by the administrator. A probe file 
that corresponds to the installed probe must be selected for 
proper functioning of protocols within VnmrJ.

Priority sample

A priority sample is submitted to the Study Queue by 
checking the Priority Sample box before submission. The 
sample is run after data acquisitions for current sample is 
completed, and before the other samples submitted to the 
Study Queue are run. The ability to run a priority sample 
can be assigned to an operator by the VnmrJ administrator.

Protocol

A protocol consists of any single or series of NMR 
acquisitions. A protocol may be a simple NMR experiment or 
involve a series of shorter acquisitions that are acquired but 
not stored in order to establish necessary parameters (such 
as solvent location) for the desired NMR experiment.
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Required experiment/protocol

A required experiment/protocol is an experiment/protocol 
consisting of one or more required experiments that are 
executed before the desired data set is acquired. All 2D 
protocols in the walkup interface require that a proton 
apptype protocol is run before the 2D protocol is run. 
Selecting a 2D protocol, such as the Cosy protocol, 
automatically adds a proton protocol ahead of the 2D 
protocol. The requirements for running a proton apptype 
protocol is met if a proton apptype protocol (proton, 
preset, or wet1d) already exits in the list of experiments 
before the 2D. A required proton experiment, that is part of 
the 2D protocol, is not added to the Study Queue. Solvent 
suppression parameters are carried forward to the 2D 
experiment if the proton apptype protocol is preset, or 
wet1d and the 2D experiment is acquired with these 
parameters. A minsw process executed if proton, presat, 
or wet1d listed ahead of any 2D experiment and, if it is not 
desired, must be turned OFF before the experiment is 
submitted.

Spectroscopy interface

The walkup is primarily designed for point and click 
acquisition of NMR experiments with or without a sample 
handler (SMS, Carousel, VAST, 768AS). 

Study

A study consists of a one or more NMR experiments 
collected on one or more NMR samples.
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Study queue

The Study Queue is an area in VnmrJ where a list of 
protocols (NMR experiments) to be acquired on a single 
sample or a series of samples is created. This area can 
reflect the sample that is active, the sample that is 
displayed, or a queue.

Traymax

The parameter traymax is used define the type of 
autosampler or sample handler associated with the NMR 
system and can have the following values.

Viewport

Activating viewports allows the user to view more than one 
workspace at a time. Each viewport must be linked to a 
specific workspace. Up to nine viewports can be open in 
VnmrJ at a time. Viewports allow the user or operator to 
look at one or more spectra (with or without linking 
cursors) at a time.

traymax = Sample handler

0 No sample handler

9 Carousel 

50 SMS with a rack for 50 samples

100 SMS with a rack for 100 samples

96 VAST
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Workspace 

The terms workspace and experiment are used 
interchangeably. Either one refers to a directory in the 
user's local vnmrsys directory called exp1, exp2, exp3, 
etc., which correspond to workspace 1, workspace 2, 
workspace 3, or equivalently, experiment 1, experiment 2, 
experiment 3 and so on. The exp directory contains 
parameters and, potentially, data for any given NMR 
experiment or protocol.

Data is directly acquired into a defined workspace or 
experiment corresponding to an exp directory in direct 
acquisition mode and must be stored into a FID file or it 
will be overwritten by the next direct, user- executed 
acquisition. The workspace or experiment can also act as a 
holding pen for processed data that is already stored on the 
disk.
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Imaging

Applications type

Experiments are grouped in types of applications such as: 
3D fast spin echo, localized spectroscopy (1D), global 
spectroscopy (1Dglobal), or EPI- like. Each application type 
has, a generic set- up, processing, and prescan procedure.

Composite protocol

A composite protocol is a series of protocols, required 
protocols, prescans, or a series of NMR data acquisitions, 
clustered together into one unit.

Exec-parameters

The exec- parameters (string parameters) define how a 
particular protocol is prepared for scan (execprep), 
processed (execprocess), or run in the prescan mode 
(execprescan). Typically, the exec- parameters contain just 
the name of a single macro, but generally they can be 
anything that could be typed on the command line or typed 
in a macro.

File types

Spectroscopy data is stored with the raw data is saved a 
single file (fid) accompanied by an ASCII file listing all 
parameters in the subdirectory name.fid. Image data is 
stored with the processed images saved as individual files 
for each slice in a 2D experiment or as a single file in a 3D 
experiment in the subdirectory name.fdf.
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Protocol

A protocol can either be a basic or composite. A basic 
protocol is a single parameter set, for example, sems or 
gems, whereas a composite protocol is a collection of basic 
protocols.

Study

A study consists of one or more scans run on a single 
subject in a single session.

Study Queue

The Study Queue is a list of protocols to be acquired. These 
protocols are coded with different colors and fonts to 
distinguish between active, completed and new protocols. 
The protocols move to the top as scans are acquired.

Viewport

There are usually three available Viewports: Plan, Current, 
and Review. Each viewport is a separate work- area with 
different functions. Use the Plan Viewport to set up 
experiments and graphically plan the slices or volume. The 
data will be acquired and displayed in the Current Viewport, 
which therefore always has the most recent data. Use the 
Review Viewport to view and analyze previously acquired 
data.
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Administrator

Administrator 

The administrator of VnmrJ (both hardware and software) is 
generally called “vnmr1” and is the owner of all files and 
directories of the VnmrJ 4 software. Typical functions of the 
VnmrJ administrator are: creating new users and operators, 
assigning appmodes and various privileges such as access to 
panels and NMR experiments, and hardware configuration 
through the “vnmr1” user login.

Application mode (appmode)

The application mode determines what features are 
displayed in the VnmrJ window. The application modes are 
Spectroscopy, LC- NMR and Imaging. The administrator 
defines each user's application mode upon the creation of 
that user's operating system login account.
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General

Folder

The user interacts with the parameters through panels in 
one of the four folders: Start, Acquire, and Process. Each 
folder can have a number of pages. The folders are found in 
the bottom horizontal region of the VnmrJ interface.

Global files

Global parameters, templates, experiments, file and so forth 
are available to all users and are stored in the /vnmr 
directory, which is owned by the administrator.

Local files

Local files (parameters, templates, experiments, probe files, 
and so forth) are stored in the user’s directory 
(~/user/vnmrsys). Local files typically are specified as the 
first application directory to search.

Locator

The locator is a database manager that helps spectroscopists 
keep track of the location of automation runs, shim files, 
protocols, acquired data and so forth. 
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Node in study queue

Each entry in the study queue is termed a node. A node is 
either a parent node (the name of the sample or a child 
node (the actual scan).

Pages

The sub- panels in each folder are called pages, panels, or 
templates. These pages have entry fields, menus, check 
boxes, and so on, for setting up sample- specific, acquisition, 
or processing parameters.

Prescan(s)

A prescan is a short acquisition generally not saved to disk 
that can be part of or precede protocols. Prescans that are 
integrated into protocols include solvent suppression 
optimization routines (presat in 90% water), and scout scans 
to find solvents for suppression. Prescans that precede 
protocols or data acquisition are automatic tuning, locking 
and gradient shimming. These prescans are set- up from the 
"Standard" page found in the "Start" folder.

Push-pin

A small icon that looks like a tack or a push- pin is located 
in the upper right of the folders and vertical panels. By 
untacking the push- pin, the user can hide the folders or 
vertical panels. A tab to the side of VnmrJ is created. When 
the mouse is rolled over the tab, the vertical panel or folder 
will be temporarily redisplayed. If permanent redisplay of 
the panel or folder is desired, the push- pin may be tacked 
in place.
122 VnmrJ 4.2 Administration Guide



VnmrJ Terms 8 
Vertical panels

The vertical panels are located on the left- hand side of the 
screen. They provide easy access to general 
cross- applications functions, which is particularly useful 
when the horizontal folders are hidden.
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Restricting User’s Data Viewing Privileges in Locator

The Locator is a database browser that provides access to 
data sets, experiments, shim sets, commands, and so on. The 
administrator can restrict how files appear in the Locator 
for each user. An access list controls the data that is visible 
to the users.

Show the access list

Use these steps to show the Access field in the User 
Information panel on the right side of the VnmrJ Admin 
interface.

1 Open the VnmrJ Administration interface, if is not already 
open.

2 Click the button with the user’s name to select the user.

3 Open the Users Defaults window:

a Click Configure.

b Select Users.

c Select Defaults.

4 Select the access check box under the Show column.

5 Click OK.

An Access line appears in the user information panel on the 
right side of the VnmrJ Admin interface.
126 VnmrJ 4.2 Administration Guide



Locator Administration 9 
Access list

The following steps describe how to set up an access list for a 
user.

1 Select a user account by clicking on the User’s Name 
button.

2 Type a space- separated list of users whose files the 
selected user can access. 
For example, if user1 will be allowed to view files for 
user2, user3, and user99, type: user2 user3 user99.

3 Click Save User.

4 Repeat for each user.
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Configuration Files

Configuration files for the Locator are contained in the 
following directories for the different appmode types:

Interface Directory

Spectroscopy /vnmr/shuffler

Individual users $vnmruser/shuffler
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Large Database Recommendations

The maximum number of items to display in the Locator can 
be controlled by setting its value in Systems Settings 
window.

Do one the following:

1 Select Edit.

2 Select System settings.

3 Click the Display/Plot tab.

4 Type a value for Max # of items to show in Locator.

Setting the value in Max # of items to show in Locator higher 
than 2000 slows down the response of the Locator by filling 
Locator table with a large number of rows. A value between 
1000 and 2000 gives optimal performance. A row is shown 
with the word Truncated if the database returns more items 
than the limit. The message indicates that more items 
returned but are not shown in the Locator to save time.

Use the following guidelines if the database contains more 
than 10000 items:

• Set the Locator to show only items that match the criteria 
of the statement as follows:

• Imager Interface

a Select Tools.

b Select System settings.

c Click the Display/Plot tab.

d Check the box next to Display only matching items in 
locator.
VnmrJ 4.2 Administration Guide 129



9 Locator Administration 
 

• Liquids Interface (Spectroscopy):

a Select Edit.

b Select System settings. 

c Click the Display/Plot tab.

d Check the box next to Display only matching items in 
locator.  
Do not type values in the Locator statement of all, etc.

• Set values in the Locator statement to match 1000 or 
2000 items.

• Do not type values in the Locator statement of all, etc.

• Use the File Browser to limit the directory scope. The 
Locator only matches items that are in and under the 
directory the browser defines if the File Browser is 
displayed.

• Set Max # of items to show in Locator between 1000 to 
2000.
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Network Database

Several computers running VnmrJ can access the same 
Postgres database server. This way, all of the VnmrJ users 
will have immediate access to data saved on other machines 
(if the user has access to that data).

This access requires that all computers running in network 
database mode be mounted to any directories of other 
computers containing data that is intended to be accessed. 
The mounts can be hard mounts listed in the vfstab file or 
automount, but they must be mounted to gain access.

Set the environment variable PGHOST to the host name of 
the machine to use for the DB server in every user account. 
The default is the local host. Different users can use 
different DB servers, or some computers can use their own 
database server. A computer which is to be a DB server will 
need the Postgres postmaster daemon running on it. If 
PGHOST is set to a remote database computer, that remote 
database will be used even if there is a local instance of a 
database running.

Non DB server computers default to network mode DB 
access by comparing PGHOST with the local host name. 
Specifying a remote host sets the non DB server computer in 
network mode. The DB server computer has itself as 
PGHOST, and the VnmrJ administrator on the server 
computer must create an empty file 

/usr/varian/config/NMR_NETWORK_DB

to force it into network mode. Data access from other 
computers will not work correctly if this is not done. 
Creating this file on a non- server computer will force the 
database into network mode.

The file /usr/varian/config/NMR_NETWORK_DB, if it is 
used, must be in place before dbsetup is run during 
installation, or the DB will not be set up correctly.
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The attribute 'hostdest' in the database contains the host 
name where the file actually resides (destination) when a 
computer is set up for network mode. The attribute 
'host_fullpath' contains hostdest:fullpath where 
fullpath is the path as it looks on the machine, 
hostdest. It does show the mounted path from the current 
machine.

Pushing automount relations from a server makes the 
following necessary:

VnmrJ must be able to translate between the mounted path 
and the actual path on the destination computer. It will first 
look for a file

  '/usr/varian/mount_name_table' 

It only uses this file if it is found. An example of this file is 
as follows:

# Table of remote system mount names and paths 
# One line per entry, Syntax: 
#host:direct_path  mount_path 
mongoose:/export/home/mongoose_home 
voyager:/export/home/home

If 'mount_name_table' is not found, it looks in 
'/etc/mnttab' and in '/etc/auto_direct' to get 
relationships. If automount relations are pushed from a 
server, they will not always be available in these files and 
will need to be put into a 'mount_name_table' file. 
Mounts from the vfstab file and from the local 
auto_direct file, should work properly without a 
'mount_name_table' file.

Changing the UNIX port number is not normally necessary, 
but might be done if more than one Postgres daemon is to 
run on the system at one time. The port will default to 5432 
unless specified otherwise in every user’s login file with the 
environment variable, PGPORT. It should be possible for 
different users (and thus different groups) to use entirely 
different database daemons and databases on the same 
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computer. If PGPORT is set to something other than 5432, 
then every user on every computer using that DB server will 
need PGPORT set in their accounts.
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Database Hints

If the Locator shows Error under the column headings, or if 
the error message, DataBase contents version is not correct, 
appears on the bottom of the screen, exit VnmrJ and run 
dbsetup in a terminal window.
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